Oracle® Fusion Middleware
Using the NetSuite Adapter
Release 12.2.1.3.0
E83335-01

July 2017
Documentation for Oracle Service-Oriented Architecture (SOA) developers that describes how to use the NetSuite Adapter.
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>v</td>
</tr>
<tr>
<td>Audience</td>
<td>v</td>
</tr>
<tr>
<td>Related Resources</td>
<td>v</td>
</tr>
<tr>
<td>Conventions</td>
<td>v</td>
</tr>
<tr>
<td>1 Introduction to the Oracle NetSuite Adapter</td>
<td></td>
</tr>
<tr>
<td>NetSuite Adapter</td>
<td>1-1</td>
</tr>
<tr>
<td>Installing the Cloud Adapters</td>
<td>1-2</td>
</tr>
<tr>
<td>Performing Postinstallation Configuration Tasks</td>
<td>1-2</td>
</tr>
<tr>
<td>Specifying the Oracle NetSuite Adapter WSDL</td>
<td>1-2</td>
</tr>
<tr>
<td>Obtaining the Authentication Credentials</td>
<td>1-2</td>
</tr>
<tr>
<td>Unsupported Features</td>
<td>1-2</td>
</tr>
<tr>
<td>2 Understanding the Oracle NetSuite Adapter Features</td>
<td></td>
</tr>
<tr>
<td>Designing an Integration with the Adapter Configuration Wizard</td>
<td>2-1</td>
</tr>
<tr>
<td>Monitoring Your Application During Runtime</td>
<td>2-2</td>
</tr>
<tr>
<td>3 Designing SOA Composite Applications</td>
<td></td>
</tr>
<tr>
<td>Creating a SOA Composite Application</td>
<td>3-1</td>
</tr>
<tr>
<td>Adding an Adapter to a SOA Composite Application as a Reference</td>
<td>3-1</td>
</tr>
<tr>
<td>Completing Design of a SOA Composite Application</td>
<td>3-2</td>
</tr>
<tr>
<td>4 Designing Oracle Service Bus Business Services</td>
<td></td>
</tr>
<tr>
<td>Creating an Oracle Service Bus Business Service</td>
<td>4-1</td>
</tr>
<tr>
<td>Adding an Adapter to a Business Service as a Reference</td>
<td>4-1</td>
</tr>
<tr>
<td>Completing Design of an Oracle Service Bus Business Service</td>
<td>4-2</td>
</tr>
<tr>
<td>5 Configuring NetSuite Adapter Properties</td>
<td></td>
</tr>
<tr>
<td>Configuring Basic Information Properties</td>
<td>5-1</td>
</tr>
<tr>
<td>What You Can Do from the Basic Info Page</td>
<td>5-1</td>
</tr>
<tr>
<td>What You See on the Basic Info Page</td>
<td>5-1</td>
</tr>
<tr>
<td>Configuring Oracle Cloud Adapter Connection and CSF Key Properties</td>
<td>5-2</td>
</tr>
</tbody>
</table>
What You Can Do from the Oracle Cloud Adapter Connection Page ......................... 5-2
What You See on the Oracle Cloud Adapter Connection Page ................................. 5-2
What You Can Do from the Oracle Cloud Adapter CSF Key Page .............................. 5-3
What You See on the Oracle Cloud Adapter CSF Key Page ........................................ 5-3
Configuring NetSuite Adapter Invoke Operation Properties ........................................ 5-4
What You Can Do from the NetSuite Adapter Invoke Operations Page ....................... 5-4
Reviewing Configuration Values on the Summary Page .............................................. 5-5
What You Can Do from the Summary Page ................................................................. 5-6
What You See on the Summary Page .......................................................................... 5-6

6 Managing Applications  
Managing the Application in Oracle Enterprise Manager Fusion Middleware Control ........ 6-1
Testing Oracle Service Bus Business Services from Oracle Service Bus Console .......... 6-1
Preface

Using the Oracle NetSuite Cloud Adapter describes how to use the Oracle NetSuite Adapter in your SOA composite applications and Oracle Service Bus business services.

Topics:

• Audience
• Related Resources
• Conventions

Audience

Using the Oracle NetSuite Cloud Adapter is intended for users who want to create, deploy, test, and monitor applications that use the Oracle NetSuite Adapter.

Related Resources

For more information, see these Oracle resources:

• Developing SOA Applications with Oracle SOA Suite
• Administering Oracle SOA Suite and Oracle Business Process Management Suite
• Administering Oracle Service Bus
• Understanding Technology Adapters

Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
This section introduces the Oracle NetSuite Adapter.

**Topics**

- NetSuite Adapter
- Installing the Cloud Adapters
- Performing Postinstallation Configuration Tasks
- Specifying the Oracle NetSuite Adapter WSDL
- Obtaining the Authentication Credentials
- Unsupported Features

**NetSuite Adapter**

The NetSuite Adapter enables you to create an integration with a NetSuite application. NetSuite is a SaaS-based application for business management. The NetSuite platform includes ERP, CRM, PSA, and e-commerce capabilities. To integrate users, NetSuite provides a platform called SuiteCloud that consists of cloud development tools and infrastructure. The SuiteTalk component of the SuiteCloud framework enables integration of NetSuite with other on-premises or cloud solutions.

While SuiteTalk provides the ability to access NetSuite data and business processes through an XML-based API, it requires skills such as Microsoft .NET or Java to build integrations with it. The NetSuite Adapter addresses these requirements by providing a no-coding approach for building integrations with NetSuite. This enables users who are not professional developers to build integrations with NetSuite.

The NetSuite Adapter provides the following features:

- Quickly and easily connect on-premises systems and applications with NetSuite.
- Rapidly integrate with both cloud applications and with existing on-premises business systems.
- Automate the process for discovering NetSuite’s web service WSDLs based on the user account.
- Eliminate the need to work with complex polymorphic data objects by elevating NetSuite records and custom objects (records and fields) to strongly-typed objects.
- Display records based on NetSuite’s categorization.
- Provide available contextual information about business objects and operations to the developer at design time.
• Provide secured invocation to NetSuite’s web services by adhering to the role-based permission structure enforced in NetSuite in a transparent fashion.

• Provide a standard adapter life cycle, controlled runtime environment, and monitoring capabilities.

For more information, see Configuring NetSuite Adapter Properties.

Installing the Cloud Adapters
This section describes cloud adapter installation details.

See the README.txt file available with the patch for instructions on installing the cloud adapters.

After you complete adapter installation, perform the tasks described in Performing Postinstallation Configuration Tasks.

Note: For information about supported versions and platforms, see the release certification matrix at Supported System Configurations.

Performing Postinstallation Configuration Tasks
You must perform postinstallation configuration tasks after installing the cloud adapters.

For information about postinstallation configuration tasks, see the Oracle Cloud Adapters Postinstallation Configuration Guide.

Specifying the Oracle NetSuite Adapter WSDL
Obtain the WSDL and connection information to specify on the Connection page from NetSuite.

Obtaining the Authentication Credentials
Obtain the user name and password that are required for creating the Credential Store Framework (CSF) authentication key in Oracle JDeveloper from your SOA domain administrator. These credentials are required for most cloud adapters.

Unsupported Features
The adapter does not support the following features:

• Adapter runtime retry configuration properties such as jca.retry.count, jca.retry.backoff, jca.retry.interval, and jca.retry.maxInterval.

• Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion Middleware Control.

• The display of properties in the Properties tab for a reference (outbound) adapter in Oracle Enterprise Manager Fusion Middleware Control (for example, service WSDL URL, CSF key used, and others). These are the reference adapters that you select on the Services and References page.

• Rejected message handling

• Metrics such as the number of invocations.
• The following message encryption and decryption features available when you right-click a cloud adapter in the Exposed Service swimlane or External References swimlane in Oracle JDeveloper:

  – Protect Sensitive Data > Encrypt Request Data for cloud adapters in the Exposed Service swimlane.

  – Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the External References swimlane.

• The policy attachments feature available when you right-click a cloud adapter in the Exposed Service swimlane or External References swimlane in Oracle JDeveloper.
The Oracle NetSuite Adapter provides the following features.

**Topics**

- Designing an Integration with the Adapter Configuration Wizard
- Monitoring Your Application During Runtime

**Designing an Integration with the Adapter Configuration Wizard**

You use the Adapter Configuration Wizard to include the Oracle NetSuite Adapter in a SOA composite application or an Oracle Service Bus business service.

The Adapter Configuration Wizard consists of configuration pages that enable you to select the artifacts required to communicate with the NetSuite application. You can configure the adapter in the outbound (target) direction.

**Note:** If the Localize Files dialog is displayed during adapter configuration, click Cancel. You cannot localize the WSDL file.

- The Basic Info page prompts you to enter a meaningful name and optional description.
- The Connection page prompts you to specify the security policy and CSF authentication key to use. The authentication key is created by clicking the Add icon to specify the key name, NetSuite company name, user name, and password.
- The Operations page prompts you to select the operation and business object on which to perform the operation.
- The Summary page displays your selections for the outbound direction.

The following artifacts are created for each adapter instance in the Applications window in Oracle JDeveloper:

- WSDL file: Only the standard WSDL file type is supported.
- JCA file: Contains the internal implementation details used by the adapter during runtime. It contains the different interaction and connection properties used by the adapter.

When application configuration is complete, you can deploy the application from Oracle JDeveloper to the runtime environment.
For information about the details to specify in the fields of the wizard pages, see Configuring NetSuite Adapter Properties.

**Monitoring Your Application During Runtime**

This section describes the design time and runtime aspects of using the adapter.

You use the runtime part of the adapter for delivering the information generated during design time to the service endpoint. You can monitor your SOA composite application or Oracle Service Bus business service from Oracle Enterprise Manager Fusion Middleware Control. You can also test your Oracle Service Bus business service from Oracle Service Bus Console.
This section describes how to design a SOA composite application with the Oracle NetSuite Adapter.

Topics
- Creating a SOA Composite Application
- Adding an Adapter to a SOA Composite Application as a Reference
- Completing Design of a SOA Composite Application

Creating a SOA Composite Application
This section provides an overview of how to create a SOA composite application in which to include the adapter as an exposed service or external reference.

1. Start Oracle JDeveloper.
2. From the File menu, select New > Application.
3. In the New Gallery dialog, select SOA Application from the Items list, then click OK. The SOA Create SOA Application wizard is displayed.
4. Specify an application name, and click Next.
5. Specify a project name, and click Next.
   The SOA composite application is displayed for designing in the SOA Composite Editor.

Adding an Adapter to a SOA Composite Application as a Reference
You can add an Oracle NetSuite Adapter to a SOA composite application as an outbound (target) reference to the External References swimlane in Oracle JDeveloper.

1. Go to the Component Palette in your SOA composite application.
2. Go to the Cloud section under Custom/Third Party.
   The adapters are displayed.
3. To create an outbound (target) reference, drag the adapter to the External References swimlane, and see the following sections that describe the wizard pages for configuring the adapter.
Completing Design of a SOA Composite Application

This section provides an overview of how to complete design of your SOA composite application and deploy the application.

1. Design the remaining contents of your SOA composite application. For example:
   a. Connect the BPEL process to the adapter. For this example, the BPEL process is connected to the adapter as an external reference:
   b. Design the contents of the BPEL process. For example:
      i. Double-click the BPEL process.
      ii. Add and configure an invoke activity to invoke the adapter.
   iii. Add and configure assign activities to copy the contents of one variable to another when sending and receiving messages to and from the adapter.
   iv. Add and configure other activities, as appropriate.

   When complete, view the SOA composite application in the SOA Composite Editor.

   For specific information about creating and designing SOA composite applications, see Developing SOA Applications with Oracle SOA Suite.

2. Deploy the SOA composite application:
   a. In the navigator, right-click the project and select Deploy > project_name.
   b. Follow the steps in the deployment wizard to deploy the SOA composite application to the application server.
Designing Oracle Service Bus Business Services

This section describes how to design an Oracle Service Bus business service with the adapter in Oracle JDeveloper.

Topics

- Creating an Oracle Service Bus Business Service
- Adding an Adapter to a Business Service as a Reference
- Completing Design of an Oracle Service Bus Business Service

Creating an Oracle Service Bus Business Service

This section provides an overview of how to create an Oracle Service Bus business service in which to include the adapter in Oracle JDeveloper.

1. Start Oracle JDeveloper.
2. From the File menu, select New > Application.
3. In the New Gallery dialog, select Service Bus Application from the Items list, then click OK.
4. Specify an application name, and click Next.
5. Specify a project name.

The Oracle Service Bus business service is displayed for designing in the Oracle Service Bus Overview Editor.

Adding an Adapter to a Business Service as a Reference

You can add the adapter to an Oracle Service Bus business service as an outbound (target) external service to the External Services swimlane in Oracle JDeveloper.

Note: If the Import OSB Resource dialog is displayed during adapter configuration, click Cancel. You cannot localize the WSDL file.

1. Go to the Component Palette in your Oracle Service Bus business service.
2. Go to the Cloud section under Service Bus.

The adapters are displayed.
3. To create an outbound (target) external service, drag the adapter to the **External Services** swimlane, and see the following sections that describe the wizard pages for configuring the adapter:

- Configuring Basic Information Properties
- Configuring Oracle Cloud Adapter Connection and CSF Key Properties
- Configuring NetSuite Adapter Invoke Operation Properties
- Reviewing Configuration Values on the Summary Page

**Completing Design of an Oracle Service Bus Business Service**

This section provides an overview of how to complete design of your Oracle Service Bus business service and deploy the application.

1. Design the contents of your Oracle Service Bus business service. For example, to configure an Oracle Service Bus proxy service in your business service:
   
a. In the Oracle Service Bus Overview Editor, right-click the **Pipeline/Split Joins** lane and select **Insert > Pipeline**.
      The Create Pipeline Service dialog is displayed.
   
b. Enter a name for the pipeline and select the project location, then click **Next**
   
c. Select **WSDL** as the **Service Type**.
   
d. To the right of the **WSDL** selection, click the **Browse** icon to select the WSDL.
   
e. Select **Application**.
   
f. Expand **Resource Chooser** and select the WSDL file, then click **OK**.
   
g. Ensure that **Expose as a Proxy Service** is selected.
   
h. From the **Proxy Transport** list, select **http**, then click **Finish**.
      The **Pipeline** component is displayed in the Oracle Service Bus Overview Editor.
   
i. Connect the external service to the **Pipeline** component.

For more information about creating and designing an Oracle Service Bus business service, see *Developing Services with Oracle Service Bus*.

2. Open the pipeline that shows the default routing.

3. Verify the service and corresponding operation are displayed in the **Routing Properties** tab at the bottom of the dialog.
   
The outbound project is ready for deployment.

4. Deploy the business service.

---

**Note:** You cannot use Oracle JDeveloper to deploy a business service to Oracle SOA Cloud Service.
a. Select the project, then select **Deploy to Service Bus Server**.

b. Follow the steps in the deployment wizard.
The NetSuite Adapter enables you to create integrations with a NetSuite cloud application.

The following sections describe the wizard pages that guide you through configuration of the NetSuite Adapter as an invoke in an integration. The NetSuite Adapter cannot be configured as a trigger in an integration.

**Topic**

- Configuring Basic Information Properties
- Configuring Oracle Cloud Adapter Connection and CSF Key Properties
- Configuring NetSuite Adapter Invoke Operation Properties
- Reviewing Configuration Values on the Summary Page

For more information about the NetSuite Adapter, see [NetSuite Adapter](#).

**Configuring Basic Information Properties**

You can enter a name and description on the Basic Info page of each source and target adapter in your integration.

**Topics**

- What You Can Do from the Basic Info Page
- What You See on the Basic Info Page

**What You Can Do from the Basic Info Page**

You can specify the following values on the Basic Info page. The Basic Info page is the initial wizard page that is displayed whenever you drag an adapter to the trigger (source) or invoke (target) area supported by your adapter.

- Specify a meaningful name.
- Specify a description of the responsibilities.

**What You See on the Basic Info Page**

The following table describes the key information on the Basic Info page.
What do you want to call your endpoint? Provide a meaningful name so that others can understand the responsibilities of this connection. You can include English alphabetic characters, numbers, underscores, and dashes in the name. You cannot include the following:
- Blank spaces (for example, My Inbound Connection)
- Special characters (for example, #;83& or rightnow4)
- Multibyte characters

What does this endpoint do? Enter an optional description of the connection’s responsibilities. For example: This connection receives an inbound request to synchronize account information with the cloud application.

Configuring Oracle Cloud Adapter Connection and CSF Key Properties
Enter the Oracle Cloud adapter configuration connectivity and Credential Store Framework (CSF) key values for your integration.

Topics
- What You Can Do from the Oracle Cloud Adapter Connection Page
- What You See on the Oracle Cloud Adapter Connection Page
- What You Can Do from the Oracle Cloud Adapter CSF Key Page
- What You See on the Oracle Cloud Adapter CSF Key Page

What You Can Do from the Oracle Cloud Adapter Connection Page
You can specify the following connection values for the Oracle Cloud adapter.
- Specify the WSDL URL for some adapters. If you are configuring the Oracle Eloqua Cloud adapter, no WSDL is required.
- Specify the security policy.
- Create the authentication key. A key created for one direction (for example, outbound) is also available for selection in the other direction (for example, inbound).

What You See on the Oracle Cloud Adapter Connection Page
The following table describes the key information on the Oracle Cloud adapter Connection page.
<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WSDL URL</td>
<td><strong>Note</strong>: This field is not displayed for the Oracle Eloqua Cloud adapter. Specify the WSDL. The WSDL is used to build integrations specific to your instance. You can also select the WSDL from a file system or another source by choosing the browser icon next to the <strong>WSDL URL</strong> field. Click <strong>File System</strong> at the top of the dialog, then browse for the WSDL.</td>
</tr>
</tbody>
</table>
| Security Policy | Select the security policy appropriate to your environment (for example, **USERNAME_PASSWORD_TOKEN**).  
- The wizard shows all policies, including those that may not be applicable. To make a correct selection, you must have a knowledge of policies. For example, you cannot select a SAML-based policy because the identity is not propagated.  
- The policies you apply to the cloud adapter are unique to the cloud adapter and do not impact other endpoints in the composite. |
| Authentication Key | Select the CSF authentication key.  
- **Add**: Click to create a new authentication key. You must specify the key name, user name, and password.  
- **Edit**: Click to edit an authentication key.  
- **Delete**: Click to delete an authentication key. |
| Test          | Click to validate the authentication key.                                                                                                     |

**What You Can Do from the Oracle Cloud Adapter CSF Key Page**

You can specify the following CSF key values for the Oracle Cloud adapter.

- CSF key name
- User name and password
- If you are configuring the Oracle Eloqua Cloud adapter only, you must specify a company name.

**What You See on the Oracle Cloud Adapter CSF Key Page**

The following table describes the key information on the Oracle Cloud adapter CSF Key page.
### Element Description

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSF Key Name</td>
<td>Specify the CSF key to enable runtime injection of credentials. The adapter uses the CSF to retrieve the username and password required for authentication with the application (for example, the Oracle Sales Cloud or Oracle ERP application). This key identifies your login credentials during design-time.</td>
</tr>
<tr>
<td>Company Name (Oracle Eloqua Cloud adapter only)</td>
<td><strong>Note:</strong> This field is only displayed for the Oracle Eloqua Cloud adapter. Specify the Oracle Eloqua company name.</td>
</tr>
<tr>
<td>Email Account and Role</td>
<td><strong>Note:</strong> This field is only displayed for the Oracle NetSuite Cloud adapter. Specify the email account and role.</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the user name for connecting to your application (for example, the Oracle Sales Cloud or Oracle ERP application). Your administrator provides you with user credentials.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for connecting to your application.</td>
</tr>
<tr>
<td>Re-enter Password</td>
<td>Re-enter the same password a second time.</td>
</tr>
<tr>
<td>Application ID (NetSuite Adapter only)</td>
<td>Enter the application ID. When creating a SOA composite application, this field is optional if you are using a NetSuite 2015 WSDL and mandatory if using a NetSuite 2016 WSDL.</td>
</tr>
</tbody>
</table>

### Configuring NetSuite Adapter Invoke Operation Properties

Enter the NetSuite Adapter invoke operation values for your integration.

#### Topics

- **What You Can Do from the NetSuite Adapter Invoke Operations Page**
- **What You See on the NetSuite Adapter Invoke Operations Page**

### What You Can Do from the NetSuite Adapter Invoke Operations Page

You can configure the following invoke operation values for the NetSuite Adapter.

- Select the operation to perform.
- Select the business object on which to perform the operation.
What You See on the NetSuite Adapter Invoke Operations Page

The following table describes the key information on the invoke Operations page.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Processing Options</td>
<td>This feature is not currently available.</td>
</tr>
<tr>
<td>Select Operation Type</td>
<td>Select the type of operation to perform on the business object:</td>
</tr>
<tr>
<td></td>
<td>• Basic</td>
</tr>
<tr>
<td></td>
<td>• Add: Adds a record into the system.</td>
</tr>
<tr>
<td></td>
<td>• Delete: Deletes a record from the system.</td>
</tr>
<tr>
<td></td>
<td>• Get: Queries the system for a record.</td>
</tr>
<tr>
<td></td>
<td>• Update: Updates an existing record in the system.</td>
</tr>
<tr>
<td></td>
<td>• Miscellaneous</td>
</tr>
<tr>
<td></td>
<td>Select a specific operation. If you select Miscellaneous, you do not need</td>
</tr>
<tr>
<td></td>
<td>to select a business object (the Select Business Objects table is not</td>
</tr>
<tr>
<td></td>
<td>visible).</td>
</tr>
<tr>
<td></td>
<td>• GetBudgetExchangeRate: Gets and filters data related to the budget</td>
</tr>
<tr>
<td></td>
<td>exchange rate.</td>
</tr>
<tr>
<td></td>
<td>• GetConsolidatedExchangeRate: Gets and filters all data related to the</td>
</tr>
<tr>
<td></td>
<td>consolidated exchange rate.</td>
</tr>
<tr>
<td></td>
<td>• GetCurrencyRate: Gets and filters the current currency rate.</td>
</tr>
<tr>
<td></td>
<td>• GetItemAvailability: Retrieves the inventory availability for a given</td>
</tr>
<tr>
<td></td>
<td>list of items.</td>
</tr>
<tr>
<td></td>
<td>• GetPostingTransactionSummary: Retrieves a summary of the actual data</td>
</tr>
<tr>
<td></td>
<td>in an account.</td>
</tr>
<tr>
<td>Filter by object name</td>
<td>Type the initial letters to filter the display of business objects.</td>
</tr>
<tr>
<td>Select Business Objects</td>
<td>Select the business object to use.</td>
</tr>
<tr>
<td>Your Selected Business Objects</td>
<td>Displays the selected business objects.</td>
</tr>
<tr>
<td>Processing Options</td>
<td>Select this link to enable and disable certain aspects of NetSuite cloud</td>
</tr>
<tr>
<td></td>
<td>application server-side processing when performing an operation.</td>
</tr>
<tr>
<td></td>
<td>• Treat Warning As Error:</td>
</tr>
<tr>
<td></td>
<td>If selected, the endpoint treats all warning messages that are displayed</td>
</tr>
<tr>
<td></td>
<td>by the NetSuite cloud application as errors.</td>
</tr>
<tr>
<td></td>
<td>• Ignore Read Only Fields:</td>
</tr>
<tr>
<td></td>
<td>If selected, the endpoint ignores read-only fields during any requests.</td>
</tr>
</tbody>
</table>

Reviewing Configuration Values on the Summary Page

You can review the specified adapter configuration values on the Summary page.
Topics

- What You Can Do from the Summary Page
- What You See on the Summary Page

What You Can Do from the Summary Page

You can review source or target configuration details from the Summary page. The Summary page is the final wizard page for each adapter after you have completed your configuration.

- View the configuration details you defined for the source or target adapter. For example, if you have defined an inbound source adapter with a request business object and immediate response business object, specific details about this configuration are displayed on the Summary page.
- Click Done if you want to save your configuration details.
- Click a specific tab in the left panel or click Back to access a specific page to update your configuration definitions.
- Click Cancel to cancel your configuration details.

What You See on the Summary Page

The following table describes the key information on the Summary page.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>Displays a summary of the source or target configuration values you defined on previous pages of the wizard. For adapters for which a generated XSD file is provided, click the XSD link to view a read-only version of the file. To return to a previous page to update any values, click the appropriate tab in the left panel or click Back.</td>
</tr>
</tbody>
</table>
Managing Applications

This section describes how to manage and monitor an Oracle SOA Suite or Oracle Service Bus application that uses the adapter from Oracle Enterprise Manager Fusion Middleware Control or Oracle Service Bus Console.

Topics

- Managing the Application in Oracle Enterprise Manager Fusion Middleware Control
- Testing Oracle Service Bus Projects from Oracle Service Bus Console

Managing the Application in Oracle Enterprise Manager Fusion Middleware Control

You manage the SOA composite application or Oracle Service Bus business service that includes your adapter in Oracle Enterprise Manager Fusion Middleware Control.

1. Log in to Oracle Enterprise Manager Fusion Middleware Control.

2. In the navigator, expand the tree to display your SOA composite application or Oracle Service Bus business service project (for this example, a SOA composite application is selected).

3. Select the SOA composite application.

4. Click Test.

   The Test Web Service page is displayed.

5. Complete the fields on the page to initiate a test of your composite.

6. Click Test Web Service.

   Invocation results are displayed.

7. Click Launch Flow Trace to view the flow trace of the SOA composite application, including flow details about the adapter.

   For more information about monitoring applications from Oracle Enterprise Manager Fusion Middleware Control, see Administering Oracle SOA Suite and Oracle Business Process Management Suite and Administering Oracle Service Bus.

Testing Oracle Service Bus Business Services from Oracle Service Bus Console

You can test Oracle Service Bus business service projects from Oracle Service Bus Console.
1. Log in to Oracle Service Bus Console.

2. In the navigator under All Projects, open the project to test.

3. In the navigator, click the business service for that project.

4. Click the Launch Test Console (green arrow button) to test the outbound endpoint.
   
   This opens a window that displays the proxy service and the operation to test.

5. Provide the input and click Execute.

   This sends the payload to the Oracle Cloud application. The response is displayed under the Response Document section.

   For more information about testing Oracle Service Bus business service projects, see Administering Oracle Service Bus.